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Sharp

Level 1

* At level 1 the “Sharp” Setting provides a
broadband reduction in the EEG from 1 to
38 Hz at Cz.

* By rewarding this reduction the setting
targets the most elevated amplitude in
the spectrum (usually the slow waves
including alpha) and helps to remove

“pbrain cloud” and promotes sharpness of
thought.

Allp ~ols f r demo c".d research purpos ly Clin s must determine protocol choices. All protocols must
be d h cope of * .actice nd scope of co p ence.



Sharp

Level 1

« “Brain Fog” or slowness of thought is a mental
state inflicting many whether from poor
nutrition, metabolic stress or the result of
anesthesia from surgery, chemotherapy or
recovery from disease. Sharp is a setting
which helps to gently awaken the mind by
reducing slow waves, particularly high
amplitude slow alpha which tends to idle the
brain thus dulling it to the external
environment.

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



Sharp

Level 1

Lets Begin

* Make Sure the Atlantis Amplifier is plugged in.

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



Sharp

Level 1

 Open BrainAvatar by double-clicking the
BrainAvatar Icon

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



 The BrainAvatar Setup Window will Appear

¥ ° BrainAvatar Setup [i_E-J

-

Main lLogin ] Folder ] Settings] EDF Browser] Review] Global Settings]
l
Welcome to BrainMaster BrainAvatar LOGIN OK: SM: 560399
EXP DATE: 11/2/2016
Current Trainee/Study Folder: CLINICAL LICENSE
Trainee ID: BUSTest
| I
TEIEE HESEESE Folder Selections )
Name:
Comment: |Alert Beta Up Theta Hibeta Down Run XL Session
Next Session Number: Total Sessions Available: View or Chalge Settings
1 40
Training screen is Not Running EDF Brt\ser
Exit Product Manuals Review Sessio\ResuIts
Logged in, device type Discovery \ | |

e C(Click “Folder Selections”.

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



¥ ' BrainAvatar Setup

The Select Folder Screen will appear.

I Main ] Login  Folder |Settings| EDF Browser] Reviewl Global Settingsl
Select Folder I Create Folder | Folder Notes | Session Librarian | Edit Folder Info. |

Select Folder: (you may double-click to select)

m

Study Name (Trainee ID):

Trainee Name:
Brolad4chPZOKP3P40102

BroJad4chPZOKP3P40102

Comment:
comment N
Sessions Used: 4
Max Sessions: 40
Session Librarian

Administer Session Genie Push Current Study to Server

SR Delate Archive Current Study

EI Study Name I Birth Date [ Sess ] Max ] Comment I Technician I Physician Trainee Name ] Created I Modified
= .
‘5 BUSTest 2000-7-4 40 Alert Beta Up T... EEG tech BUSTest 2016-8-3 2016-8-3 1:

Archive Current Study and Delete

Create New Folder

Edit Folder Info.

Folder Notes ’
Select And Run I

Logged in, device type Discovery

All prot. ~ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must

be used w ‘*hin scope of ~.actice and scope of competence.
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¥ ' BrainAvatar Setup

The Select Folder Screen will appear.

I Main ] Login  Folder |Settings| EDF Browser] Reviewl Global Settingsl
Select Folder I Create Folder | Folder Notes | Session Librarian | Edit Folder Info. |

Select Folder: (you may double-click to select)

m

Study Name (Trainee ID):

Trainee Name:
Brolad4chPZOKP3P40102

BroJad4chPZOKP3P40102

Comment:
comment N
Sessions Used: 4
Max Sessions: 40
Session Librarian

Administer Session Genie Push Current Study to Server

SR Delate Archive Current Study

EI Study Name I Birth Date [ Sess ] Max ] Comment I Technician I Physician Trainee Name ] Created I Modified
= .
‘5 BUSTest 2000-7-4 40 Alert Beta Up T... EEG tech BUSTest 2016-8-3 2016-8-3 1:

Archive Current Study and Delete

Create New Folder

Edit Folder Info.

Folder Notes ’
Select And Run I

Logged in, device type Discovery

All prot. ~ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must

be used w ‘*hin scope of ~.actice and scope of competence.
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 The Select Folder Screen will appear.

# ' BrainAvatar Setup

l Main ] Login Folder ISettings‘ EDF Browser\ Review‘ Global Settlngs|
Select Folder |Create Folder | Folder Notes | Session Librarian | Edit Folder Info. |

Select Folder: (you may double-click to select)

‘[ Study Name | Birth Date | Sess | Max I Comment | Technician | Physician Trainee Name i Created | Modified +

,3 BUSTest 2000-7-4 40 Alert Beta Up T... EEG tech BUSTest 2016-8-3 2016-8-3 1

<

Study Name (Trainee ID):
Brolad4chPZOKP3P40102
Comment:
comment

Trainee Name:

BroJad4chPZOKP3P40102 Create New Folder
4 Folder Notes
40

Edit Folder Info.

Logged in, device type Discovery / |

Session Librarian

Administer Session Genie Push C“"aen”dt gteﬁ'sg'ew Server e Current Study ‘ Archive Current Study and Delete

e Click the Study (Folder) you would like to open (in this
case BUSTest) and then click “Select and Run”.

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



 The BrainAvatar Acquisition Screen is illuminated. Let’s
load the original Sharp Level 1 Setting File.

ta Bsplay FreqBands Sound Themes Setup Help

2 A B & & 2= m W =W . 5 5 A B &
_“m ‘00 22:30 ‘655 ‘655 ‘?uV J |10secondsJ ‘EvesCIosed J |CurrentMomage J
|

1 C4-LETheta

0.0 Hz

Lobeta

Hibeta

erlav /|C\ProgramData\BrainMaster\Studies

e Click ”F|Ie” from the Mam Menu at the top.

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



* Next click “Import Settings”.

i_| Brainfwvatar

File | Data Display Freq.Bands
Mew Study

Open Study
Save Study
Save Study As
Open EEG File
Export to Loreta
Print

Screen Snapshot

Import Settings
POTT Settings

Open Studies Folder
Open Current Study
Open Recent File »
Language L

e Scroll to find the orlgmal Sharp Level 1 File and double
ClICk It Mame Date medified Type Size

£ 0701001Sharp.bdb2 1/23/2016 5:56 PM EDEZ File 142 KB

b

* The original Sharp Level 1 setting is imported into the
Test Study and is now ready for modification

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



Sharp

The Protocol is now ready to run

o e

'| BrainAvatar

File Data Display Freq.Bands Sound Themes Setup Help

“m ‘00:22:30 ‘655 ‘655 [7uv =| |10 seconds ~| |Eyes Open ~| | Current Montage -] @ 2 2
| |
ﬂ

Blinks

Start Stim

End Stim

Start Task

End Task

Moves Clench Teeth | Drowsy | Awakens Cough/Sneeze Loose Sensor

1 Cz-LE

0.0 kohm

1 Cz-LEDelta

[*[*T\ Acanisition £ Traininn % Tah 3 x Tah 4 » Tah 5 % Tah 6 % Review » Overlav 7 |C\ProgramData\BrainMaster\Studies SMUOHO00704 CZSHARP stopped 1 0 b -

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



Sharp

Click the “Go” Button

1 BranAvatar o T
' ound Themes Setup Help

- -~
‘ — Stap ‘00:22:30 ‘655 ‘655 [7uv -| |10 seconds -| |Eves Open ~| | Current Montage -] (@ ]

Blinks Moves Clench Teeth | Drowsy | Awakens Start Stim End Stim Cough/Sneeze Loose Sensor Start Task End Task Edit

1 Cz-LE

0.0 kohm

1 Cz-LEDelta

[*[*T\ Acanisition £ Traininn % Tah 3 x Tah 4 » Tah 5 % Tah 6 % Review » Overlav 7 |C\ProgramData\BrainMaster\Studies SMUOHO00704 CZSHARP stopped 1 0 b -

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



Sharp

The Following Pop Up will appear

Ready to Start!
Place EEG Cap
Hit OK to Start Mow

Hit Cancel to Start Later

This is an indication to do one of two things:

1. Place the 19ch cap on the clients head and prep it using Cz, the two ear
clips and the GND only or,

2. Place an electrode at Cz, two ear clips and one at a suitable ground
location with the other ends plugged into the appropriate slots in the lid
of the discovery.

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



All prot. ~ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.
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Click “OK”

Ready to Start!
Place EEG Cap
Hit OK to Start Now

Hit Cancel to Start Later

Cancel |

When you click “OK” BrainAvatar will begin recording EEG.
1. Check to make sure that the EEG is recording properly.
a. If not then check all your connections and impedances. Make sure there is no
interference and that all cell phones are off
b. If the EEG is correct then click “OK” on the Pop Up and commence the session.

Meadule is Running!

To Start this Session,

Press OK When EEG Signal is Good!

Press Cancel to Cancel this Session for now

Cancel

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



Sharp

The protocol is designed to run for :
1. 10 contiguous 3 minute runs or 30 minutes. You may shorten the length of
the session by hitting the “STOP” key at any time.
2. Thresholding is Automatic meaning that reward and inhibits are set
automatically by the program.
a. Theta inhibit is set automatically at 20% of the time over threshold and
is reset at the beginning of each 3 minute round.
b. Beta reward is set at 60% of the time over threshold and is reset at the
beginning of each 3 minute round.
c. HiBeta inhibit is set at 10% of the time over threshold and is reset at the
beginning of each 3 minute round.
Points are accumulated at the top of the screen.
4. A variety of games are provided to help engage the client.

¥

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



Sharp

Take a moment and check the EEG is good. If not, then take necessary action

File Data Display Freq.Bands Sound Themes Setup Help

“ m ‘00: 11 ‘000 ‘ [ 1uv -] [10seconds ~| |Eyes Closed »| | Current Montage  ~| @ ~

\View Playback \In Playback Mode

Blinks ‘ Moves | Clench Taeth‘ Drowsy ‘ Awakens | Start Stim‘ End Stim ‘ Cough/Sneeze ‘ Loose Sensor | Start Task‘ End Task ‘ Edit

|

|
| i i

" I il
1 C3-AL Raw EEG ‘MHH‘ ‘ ‘H‘\‘ '.n" UH|.\“,;U i h“l'L“'llJ“'l‘"rIIL'IIL’l'l]ﬂ “||||| n'w\,” m\ﬂu Jiv i I,L

W\

I
My ‘”M" !

‘ | X il ‘
WWMWMWMWJWWMMJ

rj |

I
ll”
‘J‘J

wmn i

M W

I ““\II[U‘ :

Theta

Hibeta || gl wl”uﬂ {”{"Iﬂﬂ \“ﬂhﬂlllﬂlﬂlp ,l"”“ ﬂ'lu.u{\mhr Il ‘Huw“h ‘F‘"\“‘ '|ﬂ||h|,'u||\lln||"“| il .\||ﬂ ””'ljﬂllr‘\""ﬂ||”||t"‘"‘lr‘l"-”“ oo ""“h A ".'.\‘L'| A U'||r|'ﬂ,.'_.w'|lﬂl|m||'\| |\|H|nl|L|‘Hl|‘\ 'u"g

[Ty Acauiiti Trainina » Tah 3 ) Tab 4  Tah 5 , Tah 6 3 Review 3 Overlav / |C\ProgramData\BrainMaster\Studies et runnin g

Next...pléase switch from the Acquisition Tab to the Training Tab by clicking
“Training”

All prot. ~ols are for demo c-.d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



Sharp

| BrainAvatar | Tl e

File Data Display FreqBands Sound Themes Setup Help

O T T os:18 72 | T s dllBeom oot o B |

|View Playback ‘In Playback Mode
Edit

Blinks Moves Clench Teeth Drowsy Awakens Start Stim End Stim Loose Sensor Start Task End Task

Delta (Down)

6.1

Cough/Sneeze

=]

|IIH|IIHI- Illl\EYH ‘HII‘HII'\ \llll\l

|IH§HHIEII|I\\I|H\"HII‘HII'\"\lIIHI .

|IIH|IIHI: Illlﬁﬁl\\ ‘HII‘HII'\ \llll\I
5 |IIH]IIH|E II|IHI|H\"HII‘HII'\"\'III*

=]

€
€

Delta (Down)

Percent Reward -
Press Y to Manually Reset Thresholds

Delta and HiBeta meters only warn if Sleep or Anxiety are Present - They may be set Manually

<| [\ Acauisition _} Trainina { Tab 3 5 Tah 4 % Tah 5 3 Tab 6 3 Review j Overlav /|C\ProgramData\BrainMaster\Studies SMUOH000704 CZSHARP running

Your screen should now look something like this.

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.




Start Stop Countdown Timer Points scored when all
Session Session started at 30 min  criteria have been met

'| BrainAvaier

N L O Nl

~| | Current Montage - | a -

|View Playback |In Playback Mode

Blinks | Moves ‘ Clench Teeth| Drowsy ‘ Awakens | Start St|m| End Stim ‘ Cough/Sneeze | Loose Sensor | Start Task‘ End Task | Edit ‘

Broadband (Down)

!

| I HI‘|IIII|HH|\"\|HII| -

40.00

Amplitude in
microvolts

0.00

éﬂ

|IIII|IIII|:I ﬁ
hie

&

Percent Rewar o™

Press Y to Manually Reset Threshol® -
Delta and HiBeta meters only warn if Sleep or Anxiety are Present - They may

<[*[ Acauisition _» Trainina {Tah 3 3 Tah 4 % Tah 5 } Tah 6 3 Review 3 Overav /|C\ProgramData\BrainMaster\Studies

HiBeta (Down)

|IIII|IIII|= |\|\|ﬁ‘u |IIII|HH|\ \|HII|

SMUQH000704 CZSHARP

running

Graphs of
Amplitude
and

Threshold

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must

be used w ‘*hin scope of ~.actice and scope of competence.




Sharp

To set the Delta Thermometer

Delta (Down) Locate a high amplitude of Delta (16

(=]

microvolts)

A

|IIII|IIIm'II|IIII|III |IIII|IIII|I 11 ‘III|

o |IIIIIIIII|I'II|IIII|I."!IIII|IIII|I'II|I |%

=]

Delta (Down)

Adjust the threshold to a point slightly
above the amplitude observed above
(18 microvolts)

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must

be used w ‘*hin scope of ~.actice and scope of competence.

Delta (Down)

12.7

=

|IIII|IIII|I II|EH|III |IIII|IIII|I iI|IIII|

Delta (Down)

o |IIIIlIIII|I'II|IIII|III'|IIII|IIII|I'II|III*

2

=]




Sharp

TO PRIME THE AUTOMATIC
THRESHOLDING HIT THE “Y” KEY
THIRTY (30) SECONDS AFTER THE
PROGRAM IS STARTED.

If there seems to be a disparity between the automatic
thresholding and the actual microvolts, hitting the “Y”
key anytime will cause the threshold to equal the actual

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



Reading the Thermometer

60 | e—__ Automatic Setting for % of
time above Threshold

Actual % of time above
Threshold

"III|||III|I II|I||||IIII|IIII||III|I II|II|I|
; I”IIII]IIII|]:’II|IIII|III][IIII]IIIIlI'II|IIII|

~~— Automatic Threshold

Current microvolts Setting in microvolts

produced by the brain

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



Flash Player for Games

Click “Window”

| BrainAvatar, C=roe

File Data Display Freq.Bands Sound Themes Setup Helg

“m Window Client ‘21:45 ‘1726 ‘ TV ~| [10seconds ~| |Eyes Open | | Current Montage  ~| r@ = 2

\View Playback |In Playback Mode

Blinks ‘ Moves | Clench Teeth| Drowsy | Awakens ‘ Start St\m| End Stim ‘ Cough/Sneeze | Loose Sensor | Start Task‘ End Task | Edit

Delta (Down)

-

|IIH‘HIII- II‘HHTH |HH|IIH|\ \‘IIIII

|IIH‘HIII= Il‘ﬁmlll\ |HH|IIH|\ \‘IIIII

o |IIIWHIIIE'II‘\HIlIH‘lHHlIIHl\ ‘\‘III&
|IIIM|III II‘HIIlIHlHHlIIHl\ \‘IIIII

Delta (Down)

Percent Reward |50 |
Press Y to Manually Reset Thresholds

Delta and HiBeta meters only warn if Sleep or Anxiety are Present - They may be set Manually

+[* [+ Acauisition _ Trainina {Tab 3 3 Tab 4 3 Tah 5 3 Tah 6 j Review 3 Overlav / C\ProgramData\Brainhaster\Studies SMUOHD00704 CZSHARP running 4 7 0 -

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



Flash Player for Games

Window Launcher . |
Popups BMr Multimedia BMr Macromedia | CIICk ”Flash
X-Wing BoxFlow MultiMedia Player Flash Player ‘ P|ayer"
Dimmer Mini BMirr DVD Player Additional Software
2D Spectral| BrainScape ;
P P Audio/Video Interfaces EEG Synthesizer ‘
Mumbers | TrendWiew :
AVI Extensions Zukor Launcher ‘
Thermos | LongTrend
: Contributed Games
Wawves Circles
George Martin's Puzzle Space
LissaView | ReturnMap , .
Jim Zdunek's Cricket BugRun

Cancel Ok

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.
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Flash Player for Games

i ° FlashPlayer for BrainMaster

Bl |5

File Edit VYiew Help
Game: Protocol Type:

Game Type:

|appBuxes.swl j |Standard BMr

j |BrainMasler j

BioPLAY_Goldfishing.swf
BlimpRace.swf

Flash Bars for BrainMaster

blimpRace3D.swf
BrainCats.swi
BrainCats2.swf
BrainCats3D.swf
BrainCell.swf
BrainCell1.swf
BrainMan. swf
BrainMan2.swf

BrainPlanets1.swf
BrainPlanets1lite.swi
BrainPlanets2. swf
BrainPlanets2lite.swi

ColorQuest.swf
Geranium Proportional 1.5wf
Linear Dart on Target.swf

Robot Proportional 1.s5wi

Low Inhibit
(keep small)

Ready

Enhance

(keep large and bright)

Points Earned:

1076

High Inhibit
(keep small)

0.00

0.00

0.00

10.76

1.00

539

1.20

8.19

Click “Blimp Race”

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must

be used w ‘*hin scope of ~.actice and scope of competence.



Blimp Race

& FlashPlayer for BrainMaste
File Edit View Help

Game:

BlimpRace.swf

Protocol Type: |Game Type:

Standard BMr

j’ BrainMaster

H e

Ready

[000 [000 [000 [1179 [000 [292 [459 [673

The blimp advances and the lane flashes yellow each time all three criteria are met

All prot. ~ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.
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Brain Cats 2

% FlashPlayer for BrainMaster
File Edit View Help

Game: Protocol Type: }Game Type: |
BrainCats2.swf j Standard BMr ;H BrainMaster L]

on

Races Run Today: | Ra!oes['

[0.00 [000 [000 1343 [100 (394 [665 [599

The Cat advances and the lane flashes yellow each time all three criteria are met

All prot. ~ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.
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DVD’s
Click “Window”

& | BrainAvatar =

File Date Display FreqBands Sound Themes Setu

“ m ‘21 -45 ‘1 726 ‘ | Tuv ~| [10seconds ~| |Eyes Open ~| | Current Montage  ~| r@ ~ s

| View Playback ' In Playback Mode

Blinks | Moves | Clench Teath‘ Drowsy | Awiakens | Start St\m End Stim Cough/Sneeze | Loose Sensor ‘ StartTask| End Task ‘ Edit

Delta (Down) Broadband (Down)

e EE

-

|HII‘IIH|‘ HlHHYH ‘IHIlHHlI \‘IHI'

—
18

e |HII1IIH|€ HlHIIlIH"IHIlHHlI '\‘IH%
|

Delta (Down)

Percent Reward -
Press Y to Manually Reset Thresholds

Delta and HiBeta meters only warn if Sleep or Anxiety are Present - They may be set Manually

<[\ Acauisition 3 Trainina {Tab 3 5 Tah 4 & Tah 5 % Tah 6 3 Review & Overlav /7 |C\ProgramData\BrainMaster\Studies SMUOH000704 CZSHARP running

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



DVD’s

Window Launcher
Popups BMr Multimedia BMr Macromedia
X-Wing BoxFlow MultiMedia Player Flash Player -
Dimmer Mini BMirr DVD Player Additional Software
2D Spectral| BrainScape ;
P P Audio/Video Interfaces EEG Synthesizer
Mumbers | TrendWiew :
AVI Extensions ‘ Zukor Launcher ‘
Thermos | LongTrend
: Contributed Games
Wawves Circles
George Martin's Puzzle Space
LissaView | ReturnMap , .
Jim Zdunek's Cricket BugRun

Cancel Ok

b x J |

Place a DVD in the
DVD Player

When the default
DVD Player
engages “CLOSE
IT”

Click “DVD Player”

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.
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If this error message pops up
simply click OK

. b Cannot find the current study file "control\ Cur_stud".

The DVD player will not be able to save bookmarks.

Next this typical DVD control box

will appear. Hit the play button to
start the DVD

M« 11 B =

- The DVD will brighten and get
fife: 0 Chapter: 0 [¥]Modulate Video  '0Ume Brightness louder when criteria are met.
Aroion 000000 Dot Ao Adjust the volume and brightness
: with the sliders.

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.
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The Dimmer

 ——

The Dimmer is a device MLl [ e
WhICh may be used Wlth Popups BMr Multimedia BMr Macromedia '
any DVD’ Media Player’ X-Wing BoxFlow MultiMedia Player Flash Player ‘ |
internet app or YouTube Dimmer | Mini BMirr DVD Player Additional Software
to provide feedback to 2D SF'Ettra' BrainScape| | i video Interfaces EEG Synthesizer |
the Cllent from any Numb*rs Trendview AWI Extensions Zukor Launcher ‘
BrainAvatar Setting. Therm‘s LongTrend
Waue‘ Circles Contributed Games
George Martin's Puzzle Space
LissaVie ReturnMap ,
Jim Zdunek's Cricket BugRun

Cancel 0K

Before clicking “Dimmer” choose an media source.

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.
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Choose a media source —in this case “YouTube”

TR T T

D High Speed Realtime Ima: X "ki

‘ €« C' 8 https://www.youtube.com/watch?v=3Cskr_WOyhk wl =

mﬂainavatar G t

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.
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Click “Dimmer”

The Dimmer

X-Wing | BoxFlow |

BMr Multimedia BMr Macromedia

MultiMedia Player | Flash Player

Dimmer | Mini ElMirr|

DVD Player | Additional Software

2D Spectral| ElrainScape|

Numbers | Trend\.-’iew|

Thermos | LongTrend|

Waves | Circles |

LissaView | ReturnMap|

] 100 %

5

|] > Fast

By Tor Ghai

Audio/Video Interfaces EEG Synthesizer

AVI Extensions | Zukor Launcher |

Contributed Games

George Martin's Puzzle | Space |

Jim Zdunek's Cricket | BugRun |

The Start Screen Window Opens

Maxed dimmed sets whether the
media disappears or simply dims

Dimming speed sets how quickly the
screen disappears

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must

be used w ‘*hin scope of ~.actice and scope of competence.
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The Dimmer

The Dimmer Window shall open which should be
sized over the media that is presented to the client.

https://www.youtube.com

mairwavatar

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



The Dimmer

YouTube is illuminated when criteria are met and
dims when they aren’t

o) Dimmer window

o' Dimmer window

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.



Other Media

As you can see there are a | etz -
myriad of media choices Popups BMr Multimedia BMr Macromedia |
ava”able SO please feel X-Wing BoxFlow MultiMedia Player Flash Player ‘
free to try all of these to Dimmer | Mini BMirr DVD Player Additional Software
your client’s content. For 2D Spectrall BrainScape| | L terfaces EEG Synthesizer |

a more extreme fhmbers || Trendview AVI Extensions Zukor Launcher ‘
experience contact Thermos | LongTrend

BrainMaster Sales and waves | Circles || [ COMtPuted Games

. . George Martin's Puzzle Space
inquire about the Zukor LissaView | ReturnMap| | | _ S —
Games. If you have

already purchased one or = x

more of the Zukor Games
their use will be covered
in Level 2 and beyond.

All prot. -ols are for demo c".d research purposes only. Clinicians must determine protocol choices. All protocols must
be used w ‘*hin scope of ~.actice and scope of competence.
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